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Abstract

Sideways information passing generation

This bachelor thesis deals with sideways information passing, which is a crucial
part of the Magic Sets method. This method’s purpose is optimization of a lo-
gical program query’s evaluation. As there is lack of open implementations of
the Magic Sets method, this work’s output is a Java application, which imple-
ments its part – sideways information passing algorithm. The second output is
a text format, in which implemented application saves its results into text files.

Key words: sideways information passing, adornment string, logical progra-
mming, optimization

Abstrakt

Generováńı graf̊u předáváńı informace

Tato bakalářská práce se zabývá konstrukćı grafu předáváńı informace, stěžejńı
součásti metody magických množin, která slouž́ı k optimalizaci vyhodnoceńı
dotazu logickému programu. Práce se t́ımto tématem zabývá, nebot’ otevřená
implementace metody magických množin je nedostupná. Výstupem je aplikace
v jazyce Java, která implementuje algoritmus konstrukce grafu předáváńı in-
formace, a návrh formátu, ve kterém jsou vypočtené grafy předáváńı informace
ukládány do textových soubor̊u.

Kĺıčová slova: graf předáváńı informace, řetězec ozdobeńı, logické programo-
váńı, optimalizace
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A.1 UML diagram tř́ıd baĺıku GUI. . . . . . . . . . . . . . . . . . . 44
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E.7 Změna zobrazeńı grafu na plátně. . . . . . . . . . . . . . . . . . 62



1 Úvod

Vyhodnocováńı ćılového dotazu ve složitěǰśıch logických programech, obsahu-
j́ıćıch rekurzi, může trvat nepřijatelně dlouho. Metoda magických množin je
jeden ze zp̊usob̊u, jak vyhodnoceńı dotazu optimalizovat. Skládá se z několika
algoritmů, jimiž transformujeme logický program na ekvivalentńı, tzv. magický
program, pro který vyhodnoceńı stejného dotazu trvá výrazně kratš́ı dobu.

Dostupných programů, implementuj́ıćıch metodu magických množin, je ve-
lice omezený počet, nav́ıc nemaj́ı otevřený zdrojový kód. Tato práce si proto
klade za ćıl prozkoumat a implementovat v jazyce Java jednu jej́ı část – kon-
strukci grafu předáváńı informace. Daľśım ćılem je navržeńı formátu, v jakém
budou vytvořené grafy předáváńı informace uloženy v textových souborech.

Aplikaci bude možno spustit ve dvou módech – dávkovém a s grafickým
uživatelským rozhrańım. V dávkovém módu, spouštěném s konzole bez daľśı
interakce s uživatelem, vytvoř́ı aplikace pro každé pravidlo logického programu
(se syntax́ı podobnou jazyku Datalog) př́ıslušné grafy předáváńı informace
a ulož́ı je do textových soubor̊u v navrženém formátu. V módu s grafickým
rozhrańım bude tvorba konkrétńıho grafu ř́ızena uživatelem.
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2 Logický jazyk

V této kapitole bude čtenář nejprve seznámen se základńımi pojmy a defini-
cemi, týkaj́ıćımi se logického jazyka obecně a poté s úpravami syntaxe kon-
krétńıho logického jazyka pro účely této práce.

2.1 Terminologie

Proměnná

Proměnná je alfanumerická posloupnost znak̊u doplněná o znak
”

“ (podtr-
ž́ıtko), která zač́ıná velkým ṕısmenem. Př́ıklady proměnných:

Jmeno, Delka_hrany, X, Y_1

Toto nejsou proměnné:

jmeno, _delka, x, 1Y

Anonymńı proměnná je taková proměnná, jej́ıž hodnota neńı podstatná.
Znač́ı se znakem

”
“ (podtrž́ıtko).

Konstanta

Konstanta je řetězec znak̊u, ohraničený apostrofy, nebo č́ıslo.

20, ’vyska’, ’21’, ’Hmotnost_auta’

Predikátový symbol

Predikátový symbol je řetězec alfanumerických znak̊u, zač́ınaj́ıćı malým ṕıs-
menem, doplněný o znak

”
“.

hmotnost_auta, vyska

Predikát

Pokud p je predikátový symbol a (a1, a2, . . . , an) seznam argument̊u, kde
ai je proměnná (může být i anonymńı) nebo konstanta, pak p(a1, a2, . . . , an)
je predikát, atom nebo literál.
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Logický jazyk

Uvažujme predikátový symbol ps, proměnné A a B, jednu anonymńı proměn-
nou a řetězcovou konstantu ‘cde’. Potom následuj́ıćı zápis je predikát a A, B,

a ‘cde’ jsou jeho argumenty.

ps(A, B, _, ’cde’)

Porovnáńı

Pokud ai a aj jsou proměnné, potom

ai > aj

ai < aj

ai >= aj

ai <= aj

ai = aj

ai \= aj

jsou porovnáńı [4] nebo binárńı porovnávaćı predikáty [1]. Porovnáńı tak-
též považujeme za literál.

Vyč́ısleńı

Vyč́ısleńı [4] je literál ve tvaru

a is e

kde a je proměnná a e výraz, jehož hodnota je přǐrazena proměnné a. Může
vypadat např́ıklad takto:

a is b * 2 * c

kde a, b a c jsou proměnné a 2 je č́ıselná konstanta.

Speciálńım př́ıpadem vyč́ısleńı jsou inkrementace a dekrementace.

a is b + 1

a is b - 1

3



Logický jazyk

Pravidlo

Pravidlo pro predikát p(a1, a2, . . . , an) zaṕı̌seme ve tvaru

p(a1, a2, . . . , an) :- L1, L2, . . . , Lm.

kde konstanty m a n jsou přirozená č́ısla, a1, a2, . . . , an jsou argumenty (tedy
proměnné nebo konstanty) predikátu p a L1, L2, . . . , Lm jsou literály.

Zápis p(a1, a2, . . . , an) reprezentuje hlavičku pravidla1 (predikát p někdy
nazýván jako predikát hlavy nebo hlavičkový predikát) a L1, L2, . . . ,
Lm tělo pravidla.

Symbol
”
,“ (čárka) znač́ı v logických jazyćıch konjunkci a

”
:-“ (dvojtečka a po-

mlčka) implikaci. Toto pravidlo tedy odpov́ıdá následuj́ıćı implikaci.

L1 ∧ L2 ∧ . . . ∧ Lm => p(a1, a2, . . . , an)

Správně zapsaná pravidla2:

p2(X, Y) :- q1(Y, X).

p3(X, Y) :- q2(_, Y), q3(X, _).

p4(X, Y ,Z) :- q4(X, Y), Y >= Z.

p5(X, Y) :- X is Y + 1.

Nesprávně zapsané pravidlo – v hlavičce je anonymńı proměnná:

p(X, _) :- q(X, Y).

Pravidlo p také může být negováno pomoćı kĺıčového slova not. V tom př́ıpadě
jej zaṕı̌seme takto:

not (p)

1V hlavičce pravidla se nesmı́ vyskytovat anonymńı proměnná
2Pro jediné pravidlo je každá anonymńı proměnná unikátńı, pouze jsou všechny stejně

značeny. To znamená, že anonymńı proměnné v predikátech q2 a q3 pravidla p3 spolu žádným
zp̊usobem nesouviśı.
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Logický jazyk

Bezpečné pravidlo

Pravidlo r nazveme bezpečným [1], pokud se každá proměnná, obsažená v hla-
vičce pravidla, vyskytuje jako argument literálu těla tohoto pravidla. To samé
plat́ı pro negované predikáty – každý jejich argument se muśı v pravidle vy-
skytovat v predikátu, který negován neńı. O pravidle, které jednu z těchto
podmı́nek nesplňuje, řekneme, že neńı bezpečné.

Následuj́ıćı pravidla nejsou bezpečná:

p(X, Y, Z) :- q1(X), q2(X, Y).

r(A, B) :- q2(B), not (q3(A)).

Pravidlo p neńı bezpečné, nebot’ se proměnná Z nevyskytuje v jeho těle. Pra-
vidlo r neńı bezpečné, protože proměnná A negovaného predikátu q3 se jinde
v těle pravidla r nevyskytuje.

Fakt

Pravidlo, které nemá tělo (m = 0), zaṕı̌seme takto:

p(a1, a2, . . . , an).

Jestliže argumenty predikátu hlavy tohoto pravidla (a1, a2, . . . , an) jsou pouze
konstanty, řekneme, že toto pravidlo je fakt [1, 4].

Pokud by některý argument hlavičky pravidla bez těla byl proměnnou, neńı
toto pravidlo bezpečné, nebot’ nesplňuje podmı́nku, že každá proměnná hlavy
pravidla se muśı vyskytovat v těle tohoto pravidla.

Následuj́ıćı pravidla jsou fakty:

p(10).

p(’12’, ’Slovensko’).

p(14, ’Rumunsko’).

Tato pravidla nejsou fakty:

p1(X).

p2(2, _).
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Logický jazyk

P1 obsahuje proměnnou a p2 neńı bezpečné pravidlo, protože v hlavičce má
anonymńı proměnnou.

Cı́lový dotaz

Jestliže p(a1, a2, . . . , an) je atom a a1, a2, . . . , an konstanty nebo proměnné,
potom

? - p(a1, a2, . . . , an)

je ćılový dotaz.

Logický program

Logický program je neprázdná množina bezpečných pravidel.

Extenzionálńı databáze

Extenzionálńı databáźı nazveme množinu fakt̊u logického programu. Predikát
definovaný extenzionálńı databáźı nazveme extenzionálńı predikát.

Intenzionálńı databáze

Intenzionálńı databáze vznikne vyhodnoceńım pravidel logického programu.
Predikát, který definuje intenzionálńı databáze, je intenzionálńı predikát.
Intenzionálńı predikáty jsou takové predikáty, které jsou definovány v hlavič-
kách pravidel logického programu.

Vestavěný predikát

Logické jazyky obvykle poskytuj́ı vestavěné predikáty, jejichž pozitivńı vyhod-
noceńı vyvolá nějakou systémovou funkci, např́ıklad sečteńı dvou č́ısel, výpis
textu na obrazovku atd.

Ekvivalentńı logický program

Řekneme, že dvě množiny bezpečných pravidel P1 a P2 jsou ekvivalentńı, pokud
pro jakoukoliv extenzionálńı databázi E produkuj́ı logické programy P1

⋃
E

a P2

⋃
E stejné odpovědi na libovolný ćılový dotaz.
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Logický jazyk

2.2 Úpravy jazyka pro účely této práce

Vyč́ısleńı, konkrétně inkrementace a dekrementace, a porovnáńı budou nahra-
zeny vestavěnými predikáty podle tabulky 2.1, kde a1 a a2 jsou proměnné. Ve
třet́ım sloupci této tabulky je uvedeno, čeho je predikátový symbol zkratkou.

Původńı literál Nahrazuj́ıćı vestavěný predikát Predikátový symbol

a1 is a2 + 1 inc(a1, a2) increment
a1 is a2 − 1 dec(a1, a2) decrement

a1 < a2 lt(a1, a2) less than
a1 > a2 gt(a1, a2) greater than
a1 <= a2 lte(a1, a2) less than or equal
a1 >= a2 gte(a1, a2) greater than or equal
a1 = a2 eq(a1, a2) equal
a1 \= a2 neq(a1, a2) not equal

Obrázek 2.1: Nahrazeńı vyč́ısleńı a porovnáńı vestavěnými predikáty.
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3 Graf předáváńı informace

Tvorba grafu předáváńı informace je stěžejńı součást́ı tzv. metody magických
množin, což je postup, kterým transformujeme vstupńı logický program na
ekvivalentńı logický program, jež nazýváme magický program. Metodu magic-
kých množin aplikujeme proto, že vyhodnoceńı ćılového dotazu rozsáhleǰśıho
logického programu obsahuj́ıćıho rekurzi může trvat př́ılǐs dlouho. Vyhodno-
ceńı stejného dotazu v ekvivalentńım magickém programu zabere výrazně méně
času. Tato práce se ovšem metodou magických množin jako takovou a jej́ımi
daľśımi součástmi zabývat nebude; v př́ıpadě zájmu se lze v́ıce dozvědět zde:
[1, 2, 3].

V této kapitole budou nejprve vysvětleny pojmy týkaj́ıćı se grafu předá-
váńı informace a poté zaveden textový formát, ve kterém bude graf předáváńı
informace v této práci uváděn. V tomto formátu také bude vypočtené grafy
předáváńı informace ukládat implementovaná aplikace do textových soubor̊u.

3.1 Terminologie

Řetězec ozdobeńı

Řetězec ozdobeńı predikátu p(a1, a2, . . . , an) je řetězec o délky n nad abece-
dou {b, f}. Pořad́ı znak̊u v tomto řetězci odpov́ıdá pořad́ı argument̊u predikátu
p a zápis p o znač́ı predikát p ozdobený řetězcem o. Ṕısmena b a f reprezen-
tuj́ı zkratky bound (vázaný), resp. free (volný). Vázaný argument je takový
argument, který odpov́ıdá znaku b, volný argument odpov́ıdá znaku f.

Uvažujme predikát p(W, X, Y, Z) a řetězec ozdobeńı fbbf. Ozdobený predikát
bude vypadat následovně:

p_fbbf(W, X, Y, Z)

Speciálńı hlavičkový predikát

Necht’ hlavičkou pravidla r je ozdobený predikát p o(a1, a2, . . . , an). Potom
p h(b1, . . . , bm), kde b1, . . . , bm jsou vázané argumenty a m je jejich počet,
je speciálńı hlavičkový predikát pravidla r. Plat́ı m < n. Jestliže m = 0, potom
speciálńı hlavičkový predikát pro daný hlavičkový predikát nevytvář́ıme.
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Graf předáváńı informace

Uvažujme následuj́ıćı pravidlo s ozdobeným predikátem hlavy:

p_bfb(X, Y, Z) :- q1(X), q2(X, Y), q3(Z, Y).

Potom speciálńım hlavičkovým predikátem pro toto pravidlo je:

p_h(X, Z)

Graf

Grafem rozumı́me reprezentaci množiny objekt̊u, u kterých je d̊uležité, a tedy
tento fakt chceme nějakým zp̊usobem znázornit, že některé jsou určitým zp̊u-
sobem propojeny. Graf G zapisujeme jako

G = 〈V, E〉

kde V je množina vrchol̊u (reprezentace objekt̊u) a E množina hran (repre-
zentace propojeńı objekt̊u).

Neorientovaný a orientovaný graf

U neorientovaného grafu hranu e chápeme jako dvouprvkovou množinu e =
{u, v}, kde u a v jsou nějaké vrcholy z množiny V grafu G, a ř́ıkáme, že tato
(neorientovaná) hrana spojuje vrcholy u a v.

U orientovaného grafu chápeme hranu jako uspořádanou dvojici 〈u, v〉, protože
zálež́ı, jak jsou vrcholy propojeny. Zápis e = 〈u, v〉 znamená, že (orientovaná)
hrana e vede z vrcholu u do vrcholu v, kdežto e = 〈v, u〉 znač́ı, že tato hrana
vede z vrcholu vdo vrcholu u (je orientována na opačnou stranu).

Představme si následuj́ıćı př́ıklad:

G = <V, E>

V - množina měst

E - množina silnic; každá vede právě mezi dvěma městy

a, b, c, d - nějaká města z množiny V

e1 = {a, b}, e2 = 〈c, d〉

Potom po neorientované hraně e1 můžeme libovolně cestovat mezi městy a a b,
kdežto po orientované hrané e2 lze cestovat pouze směrem z města c do města

9



Graf předáváńı informace

d, nikoliv naopak.

Ohodnocený graf

Ohodnocený orientovaný graf [5] (G, w) je orientovaný graf G spolu s reálnou
funkćı w : E(G) → (0,∞). Je-li e hrana grafu G, č́ıslo w(e) se nazývá jej́ı
ohodnoceńı nebo váha.

Řekneme-li např́ıklad, že funkce w určuje kvalitu silnice a do př́ıkladu z před-
choźıho bodu přidáme informaci

w(e2) = 2

znamená to, že z města c do města d vede silnice druhé tř́ıdy.

Graf předáváńı informace

Graf předáváńı informace (někdy nazýváme také úplný graf předáváńı in-
formace, dále také SIP) pro pravidlo r s ozdobenou hlavičkou je ohodnocený
orientovaný graf, ve kterém vrcholy jsou reprezentaćı speciálńıho hlavičkového
predikátu a všech predikát̊u těla pravidla r. Orientované hrany tohoto grafu
reprezentuj́ı směr předáváńı informace a jsou ohodnoceny množinou proměn-
ných, přes které se daná informace předává.

Jestliže v hlavičce pravidla neńı žádný vázaný argument, potom pro toto pra-
vidlo graf předáváńı informace neexistuje.

Pokud pravidlo nemá tělo (je faktem), graf předáváńı informace pro něj taktéž
neexistuje.

Finálńı graf předáváńı informace

Finálńı graf předáváńı informace (dále také FSIP) je úpravou (viz kapitolu
3.2.2) úplného grafu předáváńı informace . Tuto úpravu bychom mohli brát
jako zjednodušeńı p̊uvodńıho (úplného) grafu a provád́ıme ji proto, že do dal-
š́ıho kroku metody magických množin neńı potřeba úplný graf předáváńı in-
formace, resp. údaje, které z něj touto úpravou odstrańıme, jsou pro metodu
magických množin nadbytečné a jejich absence nijak neovlivńı jej́ı výstup.
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3.2 Textový formát

3.2.1 Úplný graf předáváńı informace

Formát jedné hrany

Uvažujme upravený predikát hlavy p (speciálńı hlavičkový predikát), ze kte-
rého hrana vycháźı, ćılový predikát těla qi a množinu proměnných Xi = {x1,
x2, . . . , xn}, kterými je hrana ohodnocena. Poté hranu obecně zaṕı̌seme takto:

{p} -- x1, x2, . . . , xn --> qi

Př́ıklad 1:

p = intersection_h

X1 = Elem1, Level2

q1 = xml

Výsledná hrana:

{intersection_h} -- Elem1, Level2 --> xml

Pokud p neńı predikát hlavy, zaṕı̌seme hranu obecně takto1:

{p−n, p−n+1, ..., p−2, p−1; p} -- x1, x2, ..., xn --> qi

kde p−n je predikát hlavy a 〈p−n, p−n+1〉, 〈p−n+1, p−n+2〉, ..., 〈p−2, p−1〉, 〈p−1,
p〉 představuj́ı cestu přes orientované hrany z předchoźıch iteraćı2 z predikátu
p−n do predikátu p.

Př́ıklad 2:

p−n = intersection_h

p−1 = xml

1Všechny predikáty ve složené závorce jsou odděleny čárkami, kromě posledńıho, který
je oddělen středńıkem.

2Iteraćı rozumı́me kroky algoritmu (4) až (7) z kapitoly Algoritmus na str. 17
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p = dec

Xi = {Level1}

qi = self

Dále uvažujme, že v předchoźıch dvou kroćıch vznikly postupně tyto
hrany:

{intersection_h} -- Xa --> xml

{intersection_h; xml} -- Xb --> dec

kde Xa a Xb jsou množiny proměnných, kterými jsou tyto dvě hrany
ohodnoceny a intersection h je speciálńı predikát hlavy. Výsledná hrana
v tomto kroku bude vypadat takto:

{intersection_h, xml; dec} -- Level1 --> self

Formát celého grafu pro jedno pravidlo

Nejprve kv̊uli přehlednosti a rozlǐseńı stejně se jmenuj́ıćıch predikát̊u těla pra-
vidla zaved’me konvenci, že za název predikátu (predikátový symbol) těla vždy
přidáme tečku a pořadové č́ıslo (č́ıslujeme zleva od 1 stejně se jmenuj́ıćı predi-
káty3). Neč́ıslujeme hlavičkový predikát, nebot’ ten je vždy převeden na spe-
ciálńı hlavičkový predikát.

Uvažujme následuj́ıćı pravidlo logického programu a řetězec ozdobeńı fbfb:

intersection(Line1, Line2, Element, Level1) :-
xml(Line1, Element, Order, Level1),
xml(Line2, Element, Order, Level1),
dec(Level2, Level1),
intersection(Line1, Line2, _, Level2).

Uprav́ıme predikát hlavy na speciálńı predikát hlavy a dle zavedené konvence
přeṕı̌seme pravidlo do této podoby:

intersection_h(Line2, Level1) :-
xml.1(Line1, Element, Order, Level1),

3Č́ıslujeme i predikáty s neopakuj́ıćımi se názvy.

12
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xml.2(Line2, Element, Order, Level1),
dec.1(Level2, Level1),
intersection.1(Line1, Line2, _, Level2).

Hrany, vytvořené podle algoritmu konstrukce grafu předáváńı informace (ka-
pitola 4.1) a upravené do správného formátu4 můžeme vidět na obrázku 3.1.
Důležité je zarovnáńı do tř́ı sloupc̊u. Dále také na každé řádce mezi každými
dvěma sousedńımi sloupci jsou alespoň dvě pomlčky.
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Obrázek 3.1: Hrany grafu předáváńı informace.

4Vždy jedna hrana na jedné řádce.
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3.2.2 Finálńı graf předáváńı informace

Finálńı graf předáváńı informace vznikne jednoduchou úpravou z úplného grafu
předáváńı informace. Formát, co se týče zarovnáńı sloupc̊u, zápisu proměnných
atd., je stejný.

Uvažujme, že

{p−n, ..., p−2, −1; p} -- x1, x2, ... , xn --> qi

je hrana grafu předáváńı informace ve správném formátu, zavedeném v před-
choźı kapitole (3.2.1).

Potom, pokud p je intenzionálńı predikát, bude hrana ve finálńım grafu pře-
dáváńı informace vypadat takto:

{p} -- x1, x2, ... , xn --> qi

Pokud je ovšem p extenzionálńı nebo vestavěný5 predikát, zaṕı̌seme hranu
finálńıho grafu předáváńı informace obecně takto:

{p−m, ..., p−2, p−1; p} -- x1, x2, ... , xn --> qi

kde m <= n, p−m je intenzionálńı predikát a p−m+1, ..., p−1 a p jsou predi-
káty extenzionálńı, přičemž 〈p−m, p−m+1〉, 〈p−m+1, p−m+2〉, ..., 〈p−1, p〉 předsta-
vuj́ı cestu přes orientované hrany z předchoźıch iteraćı z predikátu p−m do
predikátu p.

V př́ıpadě, že je extenzionálńı (nebo vestavěný) predikát qi, bude př́ıslušná
hrana vynechána z finálńıho grafu předáváńı informace úplně.

Př́ıklad 1:

p−n = intersection_h

p−1 = xml.1

p = dec.1

Xi = Level1

5Extenzionálńı a vestavěné predikáty maj́ı na finálńı graf předáváńı informace stejný vliv.
Budeme-li tedy kdykoliv dále v této práci mluvit o extenzionálńım predikátu či predikátech,
je možné, že některý z nich, nebo všechny, je predikát vestavěný.
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qi = self.1

Dále uvažujme že v předchoźıch dvou iteraćıch vznikly postupně hrany:

{intersection_h} -- Xa --> xml.1

{intersection_h; xml.1} -- Xb --> dec.1

kde Xa a Xb jsou množiny proměnných, kterými jsou tyto dvě hrany
ohodnoceny, a xml je extenzionálńı predikát.

Kdyby dec byl intenzionálńı predikát, výsledná hrana v této iteraci
bude vypadat takto :

{dec.1} -- Level1 --> self.1

v opačném př́ıpadě (predikát dec je extenzionálńı (nebo vestavěný))
zaṕı̌seme tuto hranu následovně:

{intersection_h, xml.1; dec.1} -- Level1 --> self.1

Př́ıklad 2:

Uvažujme pravidlo

intersection(Line1, Line2, Element, Level1) :-
xml(Line1, Element, Order, Level1),
xml(Line2, Element, Order, Level1),
dec(Level2, Level1),
intersection(Line1, Line2, _, Level2).

kde xml a dec jsou extenzionálńı predikáty. Dále uvažujme řetězec oz-
dobeńı bfbb a př́ıslušný graf předáváńı informace, který můžeme vidět
na obrázku 3.2a na str. 16.

Na stejné stránce na obrázku 3.2b vid́ıme finálńı graf předáváńı infor-
mace ve správném formát̊u po odstraněńı hran vedoućıch do extenzio-
nálńıch predikát̊u.
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(a) Hrany úplného grafu.
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(b) Hrany finálńıho grafu.

Obrázek 3.2: Hrany grafu předáváńı informace.

16



4 Konstrukce grafu předáváńı
informace

4.1 Algoritmus

Vstup

Bezpečné pravidlo a řetězec ozdobeńı.

Výstup

Graf předáváńı informace1 pro toto pravidlo a daný řetězec ozdobeńı.

Kroky algoritmu

(1) Ozdob́ıme hlavičku pravidla zadaným řetězcem ozdobeńı.

(2) Transformujeme vstupńı pravidlo nahrazeńım predikátu hlavičky speci-
álńım hlavičkovým predikátem. Graf předáváńı informace tedy nyńı ob-
sahuje uzly, které reprezentuj́ı tento predikát a všechny predikáty těla
pravidla. Neobsahuje zat́ım ale žádné hrany.

(3) Řekneme, že množina B je množina vázaných proměnných a obsahuje
všechny proměnné speciálńıho hlavičkového predikátu. Množina U pou-
žitých proměnných je prozat́ım prázdná.

(4) Do grafu přidáme hrany, ohodnocené množinou proměnných Xi, které
vedou z predikátu p do všech takových predikát̊u těla qi, které jsou pro-
pojeny s predikátem p právě přes proměnné z odpov́ıdaj́ıćı množiny Xi.
Pro každou množinu Xi plat́ı bez výjimky tyto podmı́nky:

• Všechny proměnné v této množině muśı být proměnné predikát̊u p
a qi (ale ne naopak, tedy ne každá proměnná predikát̊u p a qi muśı
být obsažena v množině Xi).

1Obecně pro jediné pravidlo a řetězec ozdobeńı může v některých př́ıpadech existovat
v́ıce r̊uzných graf̊u. Viz Poznámky k algoritmu na str. 18.
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• Všechny proměnné v této množině muśı být prvky množiny B.

• Žádná z proměnných této množiny neńı prvek množiny U.

(5) Do množiny B přidáme proměnné predikát̊u qi, a do množiny U pro-
měnné predikátu p.

(6) Pokud jsou množiny U a B shodné, tzn. nacháźı se v nich stejné prvky,
je graf předáváńı informace hotov.

(7) Z grafu vybereme predikát p takový, že všechny jeho proměnné jsou
prvky množiny B, ale zároveň všechny nejsou prvky množiny U, tzn. je
k dispozici ještě nejméně jedna proměnná, která dosud nebyla k přenášeńı
informace použita. Pokračujeme krokem (4).

Poznámky k algoritmu

1) V některých predikátech pravidla se mohou vyskytovat anonymńı pro-
měnné. Avšak každá anonymńı proměnná je vždy pro jedno pravidlo
striktně unikátńı a nemůže tedy v žádném př́ıpadě splnit podmı́nku, že
se vyskytuje zároveň ve v́ıce predikátech. (Všechny proměnné v množině
Xi muśı být proměnné predikát̊u p a qi.) Z tohoto d̊uvodu nemaj́ı ano-
nymńı proměnné pro graf předáváńı informace žádný význam a lze je
ignorovat. Anonymńı proměnné se nevkládaj́ı do množin B a U.

2) V kroku (7) může často nastat situace, že lze jako predikát p vybrat
v́ıce r̊uzných predikát̊u, č́ımž by pro zadané pravidlo a řetězec ozdobeńı
vzniklo v́ıce graf̊u předáváńı informace. Výběr predikátu p v tomto kroku
algoritmu může později ovlivnit daľśı kroky metody magických množin,
resp. jak kvalitně bude metoda optimalizovat vyhodnoceńı dotazu logic-
kého programu. My ovšem zavedeme konvenci2, že v tomto kroku budeme
vyb́ırat vždy ten predikát, který je ve vstupńım pravidle uveden nejdř́ıve.

2Samozřejmě obecně neńı nutné ji dodržovat. Zde ji zavád́ıme proto, aby byla konstrukce
grafu deterministická, tzn. pro jedno pravidlo a řetězec ozdobeńı jsme dostali vždy ten samý
graf. Vliv tohoto výběru na daľśı části metody magických množin již neńı součást́ı této práce
a proto neńı třeba se j́ım hlouběji zabývat.
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4.2 Ukázka aplikace algoritmu

Uvažujme pravidlo

child(Line1, Line2, Elem1, Elem2) :-
self(Line1, Elem1),
self(Line2, Elem2),
intersection(Line1, Line2, Elem1, Elem2),
inc(Level2, Level1),
xml(Line2, Elem2, _, Level2).

a řetězec ozdobeńı fbbf.

Dle zavedené konvence změńıme pravidlo do následuj́ıćı podoby:

child(Line1, Line2, Elem1, Elem2) :-
self.1(Line1, Elem1),
self.2(Line2, Elem2),
intersection.1(Line1, Line2, Elem1, Elem2),
inc.1(Level2, Level1),
xml.1(Line2, Elem2, _, Level2).

Nyńı můžeme přej́ıt ke konstrukci grafu předáváńı informace.

Nejprve ozdob́ıme predikát hlavičky pravidla (1)3

child_fbbf(Line1, Line2, Elem1, Elem2)

a vytvoř́ıme z něj speciálńı hlavičkový predikát (2), o kterém dále řekneme, že
pro tento krok je predikátem p.

child_h(Line2, Elem1)

Inicializujeme množiny B a U (3).

B = {Line2, Elem1}

U = {}

3Tučná č́ısla v kulatých závorkách v této kapitole odpov́ıdaj́ı krok̊um algoritmu kon-
strukce grafu předáváńı informace z kapitoly 4.1.
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Nyńı podle kroku (4) najdeme takové predikáty, které maj́ı společné proměnné
s predikátem p, a vytvoř́ıme hrany podle formátu zavedeného v kapitole 3.2.1.
Do grafu tedy přidáme tyto hrany:

{child_h} -- Elem1 ---------> self.1
{child_h} -- Line2 ---------> self.2
{child_h} -- Line2, Elem1 --> intersection.1
{child_h} -- Line2 ---------> xml.1

Př́ıslušně uprav́ıme množiny B a U (5) – tzn. do U přidáme všechny proměnné
predikátu child h a do B proměnné všech predikát̊u, kam vedou hrany přidané
v předchoźım kroku.

B = {Line2, Elem1, Elem2, Line1, Level1, Level2}

U = {Line2, Elem1}

Na prvńı pohled vid́ıme, že podmı́nka ukončeńı algoritmu (6) – shodnost mno-
žin B a U – neńı splněna a tedy pokračujeme daľśım krokem (7). Nyńı muśıme
vybrat, kterým predikátem budeme pokračovat.
V úvahu přicházej́ı tyto:

self.1, self.2, intersection.1, xml.1

Podle zavedené konvence (v tomto kroku (7) vyb́ıráme vždy ten predikát,
který je ve vstupńım pravidle uveden nejdř́ıve) zvoĺıme predikát self.1 jako
nový predikát p a pokračujeme krokem (4).

Přidáme tedy do grafu jedinou hranu, která vyhovuje podmı́nce, že má s pre-
dikátem p společné proměnné, které ještě nejsou v množině B. Těmito pro-
měnnými (zde pouze jedinou proměnnou) je tato nová hrana ohodnocena.

{child_h; self.1} -- Line1 --> intersection.1

Podle (5) změńıme obsah množiny U.

U = {Line2, Elem1, Line1}

Obsah množiny B z̊ustane nezměněn, jelikož predikáty, kam vedou hrany
(v tomto př́ıpadě jen jedna hrana) přidané v tomto kroku, nemaj́ı žádné pro-
měnné, které v B již nejsou.

20



Konstrukce grafu předáváńı informace

Podmı́nka (6) opět neńı splněna, pokračujeme tedy krokem (7), kde vybereme
predikát self.2 a pokračujeme krokem (4).

Analogicky, dle stejných pravidel, kterými jsme přidávali hrany vedoućı z pre-
dikátu intersection h a self.1, provedeme několik daľśıch iteraćı, během nichž
do grafu předáváńı informace postupně přidáme hrany:

{child_h; self.2} -- Elem2 --> xml.1

{child_h, self.1; intersection.1} -- Level1 --> inc.1

{child_h, self.1, intersection.1; inc} -- Level2 --> xml.1

Po vytvořeńı posledńı z uvedených hran budou množiny B a U po provedeńı
kroku (5) vypadat takto:

B = {Line2, Elem1, Elem2, Line1, Level1, Level2}

U = {Line2, Elem1, Elem2, Line1, Level1, Level2}

Nyńı vid́ıme, že jsou množiny shodné a proto podle podmı́nky (6) ukonč́ıme
konstrukci grafu předáváńı informace, který je t́ım pádem hotov. Můžeme jej
(resp. všechny jeho hrany) vidět na obrázku 4.1a na str. 22.

Protože názorných př́ıklad̊u neńı nikdy dost, ukážeme si také, jak by vypadal
finálńı graf předáváńı informace za předpokladu, že predikát self je intenzio-
nálńı4. Lze jej spatřit na straně 22 na obrázku 4.1b.

4Predikát intersection je intenzionálńı z definice, nebot’ se vyskytuje v hlavičce pravidla.
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(a) Hrany úplného grafu.
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(b) Hrany finálńıho grafu.

Obrázek 4.1: Hrany grafu předáváńı informace.
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5 Specifikace implementace

Konzolová aplikace

Aplikace bude spouštěna z konzole, resp. př́ıkazové řádky – parametry (na-
př́ıklad cesta ke vstupńımu souboru) budou zadávány hned při spuštěńı. To
znamená, že aplikaci nebude možné spustit př́ımo ze správce (pr̊uzkumńıku)
soubor̊u, nebot’ při tomto zp̊usobu spuštěńı nelze zadat parametry.

Dávkový a grafický mód

V dávkovém módu aplikace načte vstupńı soubor (resp. logický program) a pro
všechna pravidla v něm obsažená vypočte př́ıslušné grafy, které opět ulož́ı do
textových soubor̊u. Od uživatele nebude kromě zadáńı parametr̊u na př́ıkazové
řádce vyžadována žádná daľśı interakce.

Avšak, jak bylo řečeno v kapitole 4.1, tvorba grafu předáváńı informace
neńı deterministická1 a tud́ıž byla zavedena jistá konvence, podle které se apli-
kace v dávkovém módu chová, což znamená, že vytvoř́ı pouze jediný graf pro
každé pravidlo a řetězec ozdobeńı. V některých př́ıpadech bychom ovšem chtěli
źıskat jiný graf, než který poskytuje dávkový mód, proto bude možno aplikaci
spustit2 s grafickým uživatelským rozhrańım (dále jen GUI), kde aplikace ne-
chá uživatele jednak nač́ıst pravidlo ze souboru a vybrat řetězec ozdobeńı, pro
který bude SIP vytvářen, ale předevš́ım jak bude tvorba grafu pokračovat,
kdykoliv bude v́ıce než jedna možnost.

Aplikace v grafickém módu bude pr̊uběžně vykreslovat již vytvořenou část
grafu, aby se uživatel mohl pohodlně rozhodnout, jak je s dosavadńım výsled-
kem spokojen a na jeho základě vybrat, jak bude tvorba grafu dále pokračovat.
Nav́ıc bude GUI kromě standardńıho uložeńı do textového souboru poskyto-
vat také možnost uložit vytvořený graf jako obrázek ve formátu PNG. Velice
vhodná by také byla možnost změnit pozice uzl̊u a hran grafu na plátně před
jeho uložeńım do obrázku, kdyby se výchoźı pozice generované aplikaćı uživa-
teli neĺıbily.

1Pro jeden řetězec ozdobeńı a pravidlo lze vytvořit v́ıce graf̊u.
2Pomoćı parametru na př́ıkazové řádce.
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Specifikace implementace

Rychlost generováńı graf̊u v dávkového módu

Daľśım d̊uležitým požadavkem je, aby byly grafy generovány přijatelně rychle.
Bylo by vhodné, aby aplikace vygenerovala grafy pro všechna pravidla reálného
logického programu3 v řádu několika jednotek, maximálně deśıtek sekund. Pro
programy s méně než deseti pravidly by mělo být generováńı hotové takřka
okamžitě.

Přehlednost implementace

Aplikace by měla být implementována tak, aby se v budoucnu daly části kódu
(předevš́ım vlastńı algoritmus generováńı SIP, př́ıpadně také parsováńı vstup-
ńıho logického programu) bez větš́ıch problémů dále využ́ıt, např́ıklad v něja-
kém rozsáhleǰśım programu, který by implementoval celou metodu magických
množin. GUI by mělo být zcela oddělitelné.

Tomuto tématu – jak a které metody a části kódu lze dále využ́ıt v jiných
programech – bude věnována celá kapitola 7.

Parsováńı vstupńıho souboru

Aplikace muśı umět parsovat běžné pravidlo (i s negovanými predikáty v těle),
at’ už rozepsané na v́ıce řádek nebo zapsané celé v jedné řádce. Např́ıklad:

p1(a1, a2) :-
not(q1(a3, a2)),
q2(a3, a2, a4),
q3(a1, a3).

p2(a5, a6) :- q4(a6, a7), q5(a7, a5).

kde an jsou proměnné, qn predikáty těla a pn hlavičkové predikáty.

3Maximálně několik set pravidel, ale sṕı̌se deśıtky.
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Neńı třeba, aby aplikace uměla rozpoznat vyč́ısleńı a porovnáńı, nebot’ ty
budou nahrazeny vestavěnými predikáty (viz kap. 2.2).

Dále také aplikace bude umět rozpoznat řádkový komentář (prvńı znak
řádky je %) a blokový komentář (blok v́ıce řádek uvozený /∗ a ∗/). Komentáře
ovšem neńı dovoleno vnořovat.

25



6 Implementace

V této kapitole bude nejprve popsána struktura baĺık̊u, co který obsahuje a co
dělá. Následně již bude popsána konkrétńı implementace d̊uležitých postup̊u
a algoritmů, př́ıpadně jakým zp̊usobem byly některé z nich optimalizovány.
Popisovány pochopitelně nebudou veškeré implementačńı detaily, ale pouze
významné, či nějakým zp̊usobem zaj́ımavé části.

6.1 Struktura kódu aplikace

Aplikace je členěna do několika baĺık̊u podle obrázku 6.1, kde MainSIP je tř́ıda,
která obsahuje metodu main.

Obrázek 6.1: UML diagram baĺık̊u projektu.
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Zde pouze zevrubně nast́ıńım, co ve kterém baĺıku je; podrobněǰśı popis
a některé implementačńı detaily se nacházej́ı až v daľśı podkapitole (Vlastńı
implementace).

• Configuration – Obsahuje předně tř́ıdu s neměnnými nastaveńımi, jako
např́ıklad regulárńı výrazy použité při parsováńı vstupńıho souboru, ale
také nač́ıtá ze souboru jazyk, ve kterém bude aplikace s uživatelem ko-
munikovat.

• Representation – Reprezentace dat (grafy, predikáty, atd.) v paměti.

• Input – V tomto baĺıku se nacházej́ı tř́ıdy, zajǐst’uj́ıćı čteńı vstupńıho
programu ze souboru, jeho parsováńı a vytvářeńı reprezentace dat v pa-
měti.

• Core – Zde se nacháźı jádro aplikace – algoritmus generováńı SIP.

• Output – Zajǐst’uje převod vygenerovaných graf̊u do textového formátu
a následně uložeńı do textových soubor̊u.

• GUI – Tento baĺık obsahuje veškeré tř́ıdy, potřebné ke spuštěńı a správ-
nému běhu aplikace v módu s GUI. (UML diagram na obr. A.1.)

6.2 Vlastńı implementace

6.2.1 Reprezentace dat

Snaha byla taková, aby vztahy mezi jednotlivými datovými strukturami (viz
UML diagram tř́ıd na obr. 6.2) co nejv́ıce odpov́ıdaly realitě. Instance tř́ıdy
Rule odpov́ıdá jednomu pravidlu, načtenému ze souboru; obsahuje predikáty
(tř́ıda Node) a proměnné (tř́ıda Variable). Výčtový typ PredicateType určuje,
jestli je predikát intenzionálńı nebo extenzionálńı. Instance tř́ıdy Graph odpo-
v́ıdá SIPu a vznikne z pravidla a řetězce ozdobeńı, tzn. jedné instanci tř́ıdy
Rule nálež́ı tolik instanćı tř́ıdy Graph, kolik je možnost́ı, jak vytvořit řetězec
ozdobeńı predikátu hlavy pravidla, které př́ıslušná instance tř́ıdy Rule ucho-
vává. Instance tř́ıdy Edge potom odpov́ıdaj́ı hranám vypočtených SIPů.
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Obrázek 6.2: UML diagram tř́ıd baĺıku Representation.

6.2.2 Vstup

Nač́ıtáńı souboru

Pr̊uběh čteńı vstupńıho souboru je znázorněn pseudokódem 6.1. Ze souboru
jsou v cyklu nač́ıtány řádky a pro každou je zkontrolováno, jestli je řádkovým
komentářem, nebo začátkem blokového komentáře. V prvńım př́ıpadě je řádka
zahozena, ve druhém jsou v cyklu řádky zahazovány, dokud neńı nalezen konec
blokového komentáře. Každá platná řádka je přidávána do proměnné ruleStr,
která uchovává právě nač́ıtané pravidlo jako řetězec znak̊u. V momentě, kdy
je nalezen znak, kterým se ukončuje pravidlo, je načtené pravidlo z proměnné
zkoṕırováno do seznamu načtených pravidel (v pseudokódu proměnná rules-
List) a proměnná ruleStr je vynulována.
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Pseudokód 6.1 Nač́ıtáńı souboru

Vstup: Vstupńı soubor

Výstup: Seznam řetězc̊u znak̊u, odpov́ıdaj́ıćıch jednotlivým pravidl̊um

1: procedure readFile
2: initialize rulesList and ruleStr
3: loop:
4: while file has next line do
5: line← read next line from file.
6: if line is start of block comment then
7: while true do
8: line← read next line from file.
9: if line is end of block comment then

10: goto loop.
11: end if
12: end while
13: end if
14: if line is line comment then
15: goto loop.
16: end if
17: ruleStr← ruleStr + line.
18: if line is end of rule then
19: add ruleStr to rulesList.
20: ruleStr← null.
21: end if
22: end while
23: end procedure

Parsováńı pravidla

Pravidlo, načtené jako řetězec znak̊u, je pomoćı regulárńıho výrazu a knihovńı
metody String.split rozděleno na jednotlivé predikáty, které jsou stejným zp̊u-
sobem děleny na predikátový symbol a jednotlivé proměnné. Následně jsou
z těchto znakových řetězc̊u vytvořeny př́ıslušné instance tř́ıd Variable, Node
a Rule.
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6.2.3 Graf předáváńı informace

Tvorba instanćı tř́ıdy Graph

Protože vstupem algoritmu generováńı SIPu je instance tř́ıdy Graph, je nutné
pro každé pravidlo (Rule) nejdř́ıve vytvořit pro každý možný řetězec ozdo-
beńı instanci této tř́ıdy. Řetězce ozdobeńı jsou generovány rekurzivńı meto-
dou, která na vstupu dostává řetězec znak̊u (v prvńı iteraci prázdný), vytvoř́ı
z něj dva nové přidáńım znak̊u b a f (např. z bf vznikne bfb a bff) a poté
zavolá sama sebe pro každý z těchto dvou nových řetězc̊u. Jakmile se takto do-
sáhne požadované délky řetězce ozdobeńı, je tento řetězec přidán do seznamu
a rekurzivńı voláńı konč́ı. Pro každý z řetězc̊u ozdobeńı ze seznamu je poté
vytvořena instance tř́ıdy Graph.

Algoritmus generováńı grafu předáváńı informace

Graf je vytvářen rekurzivńı1 metodou createEdgesOneStep (viz pseudokód 6.2
nebo zdrojový kód v př́ıloze C.1), kdy jeden jej́ı pr̊uchod (respektive jedno
voláńı) odpov́ıdá jedné iteraci algoritmu generováńı SIPu (kroky (4) až (7),
viz kap. 4.1). Před voláńım této metody jsou inicializovány seznamy váza-
ných a použitých proměnných (B a U ) a do seznamu vázaných proměnných
jsou přidány argumenty predikátu hlavy. Dále je také inicializován d̊uležitý se-
znam (v pseudokódu possibleNextSourceNodes), který uchovává ty predikáty
(instance tř́ıdy Node – dále také uzel), které vyhovuj́ı podmı́nce z kroku (7).

Metoda createEdgesOneStep jako argumenty dostává uzel srcNode, ze kte-
rého budou vycházet hrany, tvořené v této iteraci (tzn. v prvńı iteraci dostává
predikát hlavy), a hranu prevEdge (instance tř́ıdy Edge), což je hrana, která
vede do uzlu srcNode (v prvńı iteraci je tedy null, nebot’ do predikátu hlavy
žádné hrany nevedou). Postupně projde každý uzel (v pseudokódu bodyNode)
těla pravidla (s výjimkou srcNode) a zkoumá, jestli má proměnné, které ne-
byly ještě použity k přenášeńı informace. Vyhovuj́ıćı proměnné (viz krok (4)
algoritmu generováńı SIPu v kap. 4.1) jsou přidány do seznamu (edgeVars).

1Rekurze byla zvolena mı́sto jednoduchého cyklu proto, že v módu s GUI je potřeba
tvorbu SIPu krokovat, což by u cyklu bylo zbytečně komplikované.
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Pseudokód 6.2 Generováńı SIPu

Vstup: Graf (Graph) bez hran

Výstup: Hrany grafu

1: initialize B and U. . Bound and Used variables
2: add head node’s variables to B.
3: initialize possibleNextNodesList.
4:

5: procedure createEdgesOneStep(srcNode, prevEdge)
6: initialize edgeVars. . List of edge’s variables
7: declare chosenNextNode.
8: for every bodyNode of Graph do . All nodes except head node
9: empty edgeVars.

10: for every variable in bodyNode do
11: if variable satisfies conditions then . See chapter 4.1
12: add variable to edgeVars.
13: end if
14: end for
15: if edgeVars is not empty then
16: if possibleNextNodesList does not contain bodyNode then
17: add bodyNode to possibleNextNodesList.
18: end if
19: add content od edgeVars to B. . Without duplications
20: Edge← (srcNode, bodyNode, edgeVars, prevEdge). . New edge
21: add Edge to Graph.
22: bodyNode’s input edge← Edge.
23: end if
24: end for
25: add srcNode’s variables to U. . Without duplications
26: if B and U do not contain same variables then
27: chosenNextNode← chooseNextNode().
28: if chosenNextNode 6= null then
29: inputEdge← input edge of chosenNextNode.
30: createEdgesOneStep(chosenNextNode, inputEdge).
31: end if
32: end if
33: end procedure
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Pokud takové proměnné byly nalezeny (tzn. edgeVars neńı prázdný), je
provedeno následuj́ıćı:

• Všechny proměnné uzlu bodyNode jsou přidány do seznamu vázaných
proměnných (B).

• Pokud bodyNode neńı obsažen v seznamu possibleNextSourceNodes, je do
něj přidán.

• Je vytvořená nová hrana (instance tř́ıdyEdge), vedoućı ze srcNode do
bodyNode, a je ohodnocena množinou proměnných edgeVars. Tato hrana
je přidána do grafu (Graph).

• Uzlu bodyNode je nastavena vytvořená hrana jako vstupńı hrana. Toto
provázáńı je nezbytné2, aby bylo možno pro každý uzel (predikát) grafu
rekonstruovat cestu, kudy byla informace předávána, až do predikátu
hlavy.

Poté je do seznamu použitých proměnných přidána každá proměnná uzlu,
ze kterého vedou hrany, vytvořené v této iteraci (srcNode). Nyńı, jestliže neńı
splněna podmı́nka ukončeńı generováńı SIPu (shodnost seznamů U a B), je ze
seznamu possibleNextSourceNodes vybrán metodou chooseNextNode (viz zdro-
jový kód v př́ıloze C.2) uzel (chosenNextNode) podle konvence zavedené v ka-
pitole 4.1 (Poznámka 2 na str. 18) a metoda createEdgesOneStep je zavolána
znovu. Jako argumenty dostává vybraný uzel a hranu, která do něj vede.

6.2.4 Výstup

Před vlastńım zápisem soubor̊u je vytvořen nový adresář, který má v názvu
časovou známku (opakované spuštěńı programu tedy nepřepisuje soubory a ad-
resáře z předchoźıch spuštěńı). V tomto adresáři je dále pro každé pravidlo ze
vstupńıho souboru založen daľśı adresář, aby byly grafy předáváńı informace
pro konkrétńı pravidlo dobře k nalezeńı a nebylo je třeba hledat v jediném
adresáři, obsahuj́ıćım stovky soubor̊u.

Každý textový soubor obsahuje p̊uvodńı pravidlo, upravené pravidlo (pre-
dikát hlavy upraven na speciálńı predikát hlavy podle řetězce ozdobeńı a predi-
káty těla oč́ıslované podle konvence zavedené v kap. 3.2.1), hrany SIPu a hrany
FSIPu. Ukázku výstupńıho textového souboru lze naj́ıt v př́ıloze D.

2Bude potřeba při uváděńı grafu do textového formátu.
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Pro každý jeden vygenerovaný graf předáváńı informace (tzn. jeden soubor)
je výstupńı text nejprve postupně složen opakovaným voláńım metody append
knihovńı tř́ıdy StringBuilder (viz zdrojový kód v př́ıloze C.3) a následně na-
jednou zapsán do souboru jediným voláńım metody write knihovńı tř́ıdy Fi-
leWriter. Každá tř́ıda baĺıku Representation překrývá metodu toString(), která
vraćı textovou reprezentaci př́ıslušné instance tř́ıdy tak, jak má být uložena ve
výstupńım souboru (př́ıloha D).

Optimalizace

Výstup do textových soubor̊u doznal největš́ı optimalizace z hlediska časové
náročnosti. V prvotńıch verźıch aplikace bylo do souboru zapisováno postupně
(tj. téměř každé nyněǰśı voláńı metody append tř́ıdy StringBuilder bylo p̊u-
vodně voláńım metody write tř́ıdy FileWriter) a formátováńı výstupu pro-
b́ıhalo pomoćı knihovńı metody String.format. Tyto dvě praktiky, předevš́ım
metoda format3, zbytečně výstup zpomalovaly a proto byly nahrazeny součas-
ným zp̊usobem.

Celková časová úspora, které takto bylo dosaženo, je významná – pr̊uměrný
čas, potřebný na načteńı jednoho pravidla, vytvořeńı př́ıslušných SIPů a jejich
uložeńı do soubor̊u, klesl přibližně na polovinu (viz kap. 8.1).

6.2.5 GUI

Veškeré tř́ıdy, nálež́ıćı GUI, se nacháźı v baĺıku GUI (viz UML diagram tř́ıd
v př́ıloze A.1), který je od aplikace zcela oddělitelný (lze jej smazat a aplikace
bude po smazáńı jedné řádky, kterou se okno GUI vytvář́ı, nadále spustitelná
v dávkovém módu). Okno GUI lze vidět v př́ıloze na obr. A.2.

Základńımi kameny GUI jsou tř́ıdy MainPanel, NodeGui, EdgeGui, Node-
GuiListener a MainPanelListener. Ostatńı tř́ıdy menš́ıho významu (triviálńı
funkčnost jako je např. vytvořeńı okna, přidáńı položek do menu atd.) neńı
třeba zmiňovat jmenovitě.

3Pro představu: starý úryvek kódu v př́ıloze C.4.1 zabere 20-krát v́ıce času, než optima-
lizovaný kód (př́ıloha C.4.2) se stejným výsledkem.
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• Mainpanel – Reprezentuje plátno na kterém je vytvářen (a vykreslován)
SIP.

• NodeGui & EdgeGui – Tyto tř́ıdy reprezentuj́ı predikát a hranu na
plátně. Rozšǐruj́ı p̊uvodńı tř́ıdy Node a Edge z baĺıku Representation4

o informace, potřebné ke správnému vykresleńı (pozice uzl̊u, u hran po-
čet a pozice zlomů atd.).

• NodeGuiListener & MainPanelListener – Nejd̊uležitěǰśı tř́ıdy GUI – de-
tekce a vyhodnoceńı akćı myši na plátně. Zajǐst’uj́ı posuny objekt̊u po
plátně, úpravy hran a výběr zdrojového predikátu do daľśı iterace kon-
strukce SIPu.

V př́ıloze a na obr. A.3 lze vidět rozpracovaný SIP s pozicemi uzl̊u a hran,
jak je generuje aplikace automaticky. Na automatické rozmist’ováńı nebyl kla-
den d̊uraz (kromě jediného požadavku – vykreslené hrany muśı být okem rozli-
šitelné od ostatńıch), nebot’ uživatel může snadno kdykoliv změnit pozice hran
i uzl̊u a nav́ıc hranám přidávat a ub́ırat zlomy, se kterými lze také libovolně
pohybovat po plátně. Hotový a poté upravený graf lze vidět na obr. A.4.

4Nejde o děděńı, tř́ıdy NodeGui a EdgeGui obsahuj́ı Node a Edge jako proměnnou.
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7 Daľśı využitelnost

V této kapitole bude uvedeno a popsáno, jak a které metody lze dobře opětovně
využ́ıt, resp. celé vyjmout z kódu a přenést do jiného programu. Jejich vstupem
a/nebo výstupem ovšem často jsou instance tř́ıd z baĺıku Representation, které
by př́ıpadně musel být přenášeny také. To samé plat́ı o tř́ıdě Constants, která
uchovává d̊uležité konstanty (regulárńı výrazy pro parsováńı pravidla atd.),
využ́ıvané ostatńımi tř́ıdami.

Metody budou uváděny postupně v takovém pořad́ı, jaké vede od vstupu
k výstupu. Popisovány pochopitelně nebudou metody, provozuj́ıćı nějakou tri-
viálńı činnost, jako např́ıklad otevřeńı souboru pro čteńı (včetně ošetřeńı výji-
mek). Veškeré metody, nálež́ıćı baĺıku GUI, budou vynechány úplně.

Nadpis podkapitoly třet́ı úrovně (např. 7.1.1 InputFileReader) určuje
tř́ıdu, nad jej́ıž instanćı (nebo staticky) jsou metody v př́ıslušné podkapitole
volány. Nadpisy podkapitol druhé úrovně odpov́ıdaj́ı baĺık̊um, ve kterých se
tyto tř́ıdy nacházej́ı.

7.1 Input

7.1.1 InputFileReader

public ArrayList<String> readFile(Scanner sc)

Metoda přečte soubor, kterému nálež́ı zaslaný Scanner, a vrát́ı seznam řetězc̊u
znak̊u, kde každý řetězec odpov́ıdá jednomu pravidlu načtenému ze souboru.

7.1.2 RuleParser

public Rule parseRule(String ruleStr)

Tato metoda naparsuje řetězec znak̊u ruleStr, odpov́ıdaj́ıćı jednomu pravidlu,
načtenému ze souboru, a vrát́ı vytvořenou instanci tř́ıdy Rule. Využ́ıvá metodu
(ta tedy neńı volána odjinud, než z této metody) parseNode.
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private Node parseNode(String nodeStr, int order)

Metoda vraćı instanci tř́ıdy Node, vytvořenou z naparsovaného řetězce znaku
nodeStr. Parametr order je pořadové č́ıslo predikátu, který tato instance tř́ıdy
Node zastupuje, ve vstupńım pravidle.

7.2 Core

7.2.1 CoreController

public void createGraphs(Rule[] rules)

Tato metoda pro každé pravidlo ze seznamu vytvoř́ı graf (instance tř́ıdy Graph)
pro každý řetězec ozdobeńı, źıskaný metodou createAdornmentVariations.

public static void createAdornmentVariations(ArrayList<String>
adornments, int requestedLength, String previous)

Rekurzivně vytvář́ı veškeré možné řetězce ozdobeńı zadané délky (requested-
Length). Prvńı parametr je seznam, do kterého budou vyhovuj́ıćı řetězce ozdo-
beńı přidávány a třet́ı parametr je řetězec znak̊u, vytvořený v předchoźı iteraci
této metody (při prvńım voláńı je tedy tento řetězec prázdný).

7.2.2 SIP

public SIP(Graph g)

Konstruktor tř́ıdy SIP inicializuje seznamy vázaných a použitých proměnných
a seznam uzl̊u, ze kterých bude vyb́ırán uzel, ze kterého povedou hrany v daľśı
iteraci algoritmu generováńı SIPu.
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public void createEdgesOneStep(Node srcNode, Edge prevEdge,
boolean gui)

Tato metoda provede jednu iteraci přidáńı hran do grafu. Je rekurzivńı, takže
za předpokladu že parametr gui je false ji stač́ı zavolat pouze jednou tak, že
srcNode bude predikát hlavy a prevEdge null. Je-li parametr gui true, zastav́ı
se, kdykoliv je v́ıce možnost́ı, jaký uzel zvolit jako zdrojový do daľśı iterace
(tzn. velikost seznamu, který je uchovává, je větš́ı než 1), a muśı být volána
znovu, jakmile bude uživatelem zdrojový uzel vybrán.

private Node chooseNextNode()

Vybere (a odstrańı) ze seznamu uzel, ze kterého povedou hrany v daľśı iteraci.
Pokud žádný takový neńı (tzn. seznam je prázdný), vraćı null.

7.3 Output

7.3.1 AllOutput

Tato tř́ıda zajǐst’uje veškerý výstup (pro všechna pravidla) do textových sou-
bor̊u1 interně po vytvořeńı instance konstruktorem bez voláńı jakýchkoliv dal-
š́ıch metod

”
zvenku“. Všechny metody maj́ı tedy v hlavičce modifikátor př́ıstu-

pové úrovně private (kromě jedné statické, která je volána z GUI bez vytvářeńı
instance této tř́ıdy). Banálńı záležitosti, jako vytvořeńı složky, kam budou sou-
bory zapisovány, nebo vytvořeńı časové známky, opět nebudou zmiňovány.

private void writeOneRule(FileWriter fw, Rule r, Graph g, boolean
gui)

Metoda zaṕı̌se do souboru, na který ukazuje zaslaný FileWriter, p̊uvodńı na-
čtené pravidlo, pravidlo upravené podle př́ıslušného řetězce ozdobeńı, hrany
SIPu, nálež́ıćı grafu g, a po transormaci SIPu na FSIP také hrany FSIPu.

1Včetně vytvářeńı potřebných složek.
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private void transformSIPtoFSIP(Graph g)

Pro graf g transformuje tato metoda SIP na FSIP. Původńı SIP neńı smazán,
instance tř́ıdy Graph uchovává seznam hran SIPu i FSIPu.

private String writeEdges(Graph g, boolean FSIP)

Tato metoda vrát́ı textový řetězec, který obsahuje (ve správném formátu)
hrany grafu g. Jestli se jedná o hrany SIPu nebo FSIPu určuje boolean FSIP.
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8 Testováńı

Aplikace byla testována předevš́ım v dávkovém módu podle dvou kritéríı –
správnosti generovaných SIPů a časové náročnosti (viz kap. 8.1). Co se týče
správnosti, nebyly v konečné verzi aplikace nalezeny žádné nedostatky; grafy
předáváńı informace, poskytované aplikaćı, se zcela shoduj́ı s ručně vytváře-
nými grafy1.

V módu s GUI byla kromě správnosti testována předevš́ım robustnost (a na-
lezené chyby odstraněny) – tzn. aplikace nespadne při špatném vstupu (např.
vstupńı soubor neńı ve správném formátu, nebo uživatel omylem (či schválně)
klikne na něco, co se od něj neočekává), ale varuje uživatele, že něco provedl
špatně.

Pozornost byla věnována také intuitivnosti ovládáńı GUI, v prvńı řadě
snadnému přemist’ováńı uzl̊u a hran na plátně.

8.1 Časová náročnost

Doby běhu aplikace byly testovány na notebooku s OS Windows 7, čtyř-
jádrovým procesorem s taktem 1.9 GHz a RAM 8GB pro logický program
z př́ılohy B (19 pravidel – 18 se 4 proměnnými v hlavičce, 1 pravidlo se 2
proměnnými) a soubor, ve kterém je tento program 20× zkoṕırován (tzn. 380
pravidel). Počet vygenerovaných graf̊u předáváńı informace pro tyto vstupńı
soubory čińı 273, respektive 5460.

V tabulce 8.1 se nacháźı pr̊uměr (zaokrouhleno na celé milisekundy) z 20ti
spuštěńı před optimalizaćı formátováńı výstupu a zápisu do souboru, v tabulce
8.2 po optimalizaci.

Počet
pravidel

Př́ıslušný
počet SIPů

Doba běhu
celkově [ms]

Doba běhu na
jedno pravidlo [ms]

19 273 2066 109
380 5640 31095 82

Obrázek 8.1: Doba běhu před optimalizaćı.

1S výstupem aplikace bylo porovnáno nejméně 20 ručně vytvořených graf̊u.
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Počet
pravidel

Př́ıslušný
počet SIPů

Doba běhu
celkově [ms]

Doba běhu na
jedno pravidlo [ms]

19 273 989 52
380 5640 14831 39

Obrázek 8.2: Doba běhu po optimalizaci.

Z tabulek lze vidět, že optimalizaćı klesl čas, potřebný na zpracováńı jed-
noho pravidla, přibližně na polovinu p̊uvodńı hodnoty. Tento výsledný čas je
mysĺım uspokojivý – na zpracováńı logického programu, obsahuj́ıćıho několik
deśıtek pravidel, neńı třeba čekat v́ıce než několik sekund.
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9 Závěr

Hlavńım ćılem práce bylo jednak navrhnout formát, v jakém budou grafy pře-
dáváńı informace uloženy v textových souborech, ale předevš́ım implementovat
algoritmus konstrukce grafu předáváńı informace. Oba ćıle se podařilo splnit.

Byla vytvořena aplikace v jazyce Java, které implementuje algoritmus kon-
strukce grafu předáváńı informace. Dále byla zavedena drobná úprava algo-
ritmu konstrukce grafu předáváńı informace, d́ıky které je konstrukce determi-
nistická.

Aplikace běž́ı ve dvou módech – dávkovém a s grafickým uživatelským roz-
hrańım. V dávkovém módu, kde se chová podle zavedené úpravy algoritmu,
aplikace vygeneruje pro každé pravidlo logického programu př́ıslušné grafy
předáváńı informace a ulož́ı je do textových soubor̊u v navrženém formátu.
V módu s grafickým rozhrańım se zavedená úprava ignoruje a konstrukci grafu
předáváńı informace lze uživatelsky ř́ıdit.

V budoucnu by mohla být implementována celá metoda magických množin,
proto byla aplikace navržena a implementována tak, aby byla bez větš́ıch úprav
rozšǐritelná o daľśı části metody magických množin, nebo se př́ıpadně daly jinde
použ́ıt některé jej́ı metody a tř́ıdy.
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Použité zkratky

• FSIP – finálńı graf předáváńı informace (angl. final sideways information
passing)

• GUI – grafické uživatelské rozhrańı (angl. graphical user interface)

• PNG – Portable Network Graphics

• SIP – graf předáváńı informace (angl. sideways information passing)
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A Obrázky

A.1 UML diagramy

Obrázek A.1: UML diagram tř́ıd baĺıku GUI.
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Obrázky

A.2 GUI

Obrázek A.2: GUI aplikace po spuštěńı.
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Obrázky

Obrázek A.3: Rozpracovaný SIP s automatický generovanými pozicemi objekt̊u
na plátně.

Obrázek A.4: Hotový SIP s upravenými pozicemi a hranami.
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B Testovaćı program

i n t e r s e c t i o n ( Line1 , Line2 , Element , 1) :−
xml ( Line1 , Element , Order , 1 ) ,
xml ( Line2 , Element , Order , 1 ) ,
l t ( Line1 , Line2 ) .

i n t e r s e c t i o n ( Line1 , Line2 , Element , Level1 ) :−
xml ( Line1 , Element , Order , Leve l1 ) ,
xml ( Line2 , Element , Order , Leve l1 ) ,
dec ( Level2 , Level1 ) ,
i n t e r s e c t i o n ( Line1 , Line2 , , Leve l2 ) .

s e l f ( Line , Element ) :−
xml ( Line , Element , , Leve l1 ) ,
inc ( Level2 , Level1 ) ,
not ( xml ( Line , , , Leve l2 ) ) .

c h i l d ( Line1 , Line2 , Element1 , Element2 ) :−
s e l f ( Line1 , Element1 ) ,
s e l f ( Line2 , Element2 ) ,
i n t e r s e c t i o n ( Line1 , Line2 , Element1 , Level1 ) ,
inc ( Level2 , Level1 ) ,
xml ( Line2 , Element2 , , Leve l2 ) .

parent ( Line1 , Line2 , Element1 , Element2 ) :−
s e l f ( Line1 , Element1 ) ,
s e l f ( Line2 , Element2 ) ,
i n t e r s e c t i o n ( Line2 , Line1 , Element2 , Level1 ) ,
inc ( Level2 , Level1 ) ,
xml ( Line1 , Element1 , , Leve l2 ) .

descendant ( Line1 , Line2 , Element1 , Element2 ) :−
c h i l d ( Line1 , Line2 , Element1 , Element2 ) .

descendant ( Line1 , Line3 , Element1 , Element3 ) :−
c h i l d ( Line1 , Line2 , Element1 , Element2 ) ,
descendant ( Line2 , Line3 , Element2 , Element3 ) .

ance s to r ( Line1 , Line2 , Element1 , Element2 ) :−
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parent ( Line1 , Line2 , Element1 , Element2 ) .

ance s to r ( Line1 , Line3 , Element1 , Element3 ) :−
parent ( Line1 , Line2 , Element1 , Element2 ) ,
ance s to r ( Line2 , Line3 , Element2 , Element3 ) .

d e s c e n d a n t o r s e l f ( Line , Line , Element , Element ) :−
s e l f ( Line , Element ) .

d e s c e n d a n t o r s e l f ( Line1 , Line2 , Element1 , Element2 ) :−
descendant ( Line1 , Line2 , Element1 , Element2 ) .

a n c e s t o r o r s e l f ( Line , Line , Element , Element ) :−
s e l f ( Line , Element ) .

a n c e s t o r o r s e l f ( Line1 , Line2 , Element1 , Element2 ) :−
ance s to r ( Line1 , Line2 , Element1 , Element2 ) .

f o l l o w i n g s i b l i n g ( Line1 , Line2 , Element1 , Element2 ) :−
s e l f ( Line1 , Element1 ) ,
xml ( Line1 , Element1 , Order1 , Leve l ) ,
s e l f ( Line2 , Element2 ) ,
xml ( Line2 , Element2 , Order2 , Leve l ) ,
gt ( Order2 , Order1 ) ,
parent ( Line1 , Line3 , Element1 , Element3 ) ,
parent ( Line2 , Line3 , Element2 , Element3 ) .

p r e c e d i n g s i b l i n g ( Line1 , Line2 , Element1 , Element2 ) :−
s e l f ( Line1 , Element1 ) ,
xml ( Line1 , Element1 , Order1 , Leve l ) ,
s e l f ( Line2 , Element2 ) ,
xml ( Line2 , Element2 , Order2 , Leve l ) ,
l t ( Order2 , Order1 ) ,
parent ( Line1 , Line3 , Element1 , Element3 ) ,
parent ( Line2 , Line3 , Element2 , Element3 ) .

f o l l o w i n g ( Line1 , Line3 , Element1 , Element3 ) :−
f o l l o w i n g s i b l i n g ( Line1 , Line2 , Element1 , Element2 ) ,
d e s c e n d a n t o r s e l f ( Line2 , Line3 , Element2 , Element3 ) .

f o l l o w i n g ( Line1 , Line4 , Element1 , Element4 ) :−
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ance s to r ( Line1 , Line2 , Element1 , Element2 ) ,
f o l l o w i n g s i b l i n g ( Line2 , Line3 , Element2 , Element3 ) ,
d e s c e n d a n t o r s e l f ( Line3 , Line4 , Element3 , Element4 ) .

preced ing ( Line1 , Line3 , Element1 , Element3 ) :−
p r e c e d i n g s i b l i n g ( Line1 , Line2 , Element1 , Element2 ) ,
d e s c e n d a n t o r s e l f ( Line2 , Line3 , Element2 , Element3 ) .

preced ing ( Line1 , Line4 , Element1 , Element4 ) :−
ance s to r ( Line1 , Line2 , Element1 , Element2 ) ,
p r e c e d i n g s i b l i n g ( Line2 , Line3 , Element2 , Element3 ) ,
d e s c e n d a n t o r s e l f ( Line3 , Line4 , Element3 , Element4 ) .
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C Zdrojové kódy

C.1 Tvorba hran grafu

//SIP s t e p 4 − f i n d i n g r e a c h a b l e nodes & c r e a t i n g
corresponding edges

public void createEdgesOneStep (Node srcNode , Edge
prevEdge , boolean gui ) {

this . lastNode = srcNode ;
ArrayList<Variable> edgeVars ;
Node chosenNextNode ;

// l e t ' s t r y to reach every body node
for (Node bodyNode : this . graph . getBodyNodes ( ) ) {

// p o s s i b l e t a r g e t node i s source node
i f ( srcNode . equa l s ( bodyNode ) )

continue ;

edgeVars = new ArrayList<Variable >() ;

// check every t a r g e t node ' s v a r i a b l e
for ( Var iab le bodyVar : bodyNode . g e tVar i ab l e s ( ) ) {

//SIP s t e p 4
i f ( bodyVar . i s V a l i d ( ) // v a r i a b l e bodyVar i s

v a l i d (= not cons tant or anonymous v a r i a b l e )
&& srcNode . g e tVar i ab l e s ( ) . conta in s (

bodyVar ) // srcNode ' s v a r i a b l e s
conta in bodyVar

&& this . boundVariables . conta in s ( bodyVar )
// bound v a r i a b l e s conta in bodyVar

&& ! this . u sedVar iab l e s . conta in s ( bodyVar )
) // used v a r i a b l e s do NOT conta in
bodyVar , t h i s p r e v e n t s us ing the same

v a r i a b l e again
{
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Zdrojové kódy

edgeVars . add ( bodyVar ) ;

//add reached node to l i s t ( i f i t i s n ' t
a l r e a d y t h e r e )

i f ( ! this . poss ib leNextSourceNodes . conta in s (
bodyNode ) )

this . poss ib leNextSourceNodes . add (
bodyNode ) ;

}
}

// does t h i s node have any v a r i a b l e s t h a t can be
used f o r p a s s i n g in format ion f u r t h e r ?

i f ( ! edgeVars . isEmpty ( ) ) {
// i t indeed does

//SIP s t e p 5 (B) − add v a r i a b l e s from reached
new node to bound v a r i a b l e s

for ( Var iab le v : bodyNode . g e tVar i ab l e s ( ) )
i f ( ! Var iab le . isAnonymous ( v ) && ! this .

boundVariables . conta in s ( v ) ) {
this . boundVariables . add ( v ) ;

}

// c r e a t e new edge and add i t graph
Edge newEdge = new Edge ( srcNode , bodyNode ,

prevEdge , edgeVars ) ;
this . graph . addEdgeSIP ( newEdge ) ;
bodyNode . setInputEdge ( newEdge ) ;

}
}

//SIP s t e p 5 (U) − add v a r i a b l e s from source node to
used v a r i b l e s

for ( Var iab le v : srcNode . g e tVar i ab l e s ( ) )
i f ( ! Var iab le . isAnonymous ( v ) && ! this . u sedVar iab l e s

. conta in s ( v ) ) {
this . u sedVar iab l e s . add ( v ) ;

}

//SIP s t e p 6 − graph c o n s t r u c t i n g cont inues , i f a l l
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Zdrojové kódy

v a r i a b l e s haven ' t been used y e t
i f ( ! i sDoneFoulproof ( ) &&

// but we a l s o don ' t want to continue , i f app i s
run wi th gu i and t h e r e i s more than one

p o s s i b l e node to go to in the next i t e r a t i o n
( ! gu i | | poss ib leNextSourceNodes . s i z e ( ) <= 1) )

{
//SIP s t e p 7
i f ( ( chosenNextNode = this . choseNextNode ( ) ) == null )

return ;

//SIP s t e p 4 ( again )
this . createEdgesOneStep ( chosenNextNode ,

chosenNextNode . getInputEdge ( ) , gu i ) ;
}

}
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Zdrojové kódy

C.2 Výběr uzlu

private Node choseNextNode ( ) {

int choseIndex , order ;
boolean isChosenOK = fa l se ;
Node chosen = null ;

// u n t i l s u i t a b l e node i s found
while ( ! isChosenOK ) {

choseIndex = 0 ;
order = I n t e g e r .MAX VALUE;

// l e t ' s f i n d which reached node has the l o w e s t
order in r u l e

for ( int i = 0 ; i < poss ib leNextSourceNodes . s i z e ( ) ;
i++) {

i f ( poss ib leNextSourceNodes . get ( i ) .
getOrderInRule ( ) < order ) {

order = poss ib leNextSourceNodes . get ( i ) .
getOrderInRule ( ) ;

choseIndex = i ;
}

}

i f ( poss ib leNextSourceNodes . s i z e ( ) < 1)
return null ;

chosen = poss ib leNextSourceNodes . remove ( choseIndex )
;

// at l e a s t one o f chosen node ' s v a r i a b l e s mustn ' t
be in used v a r i a b l e s

// i f none i s found , then we t r y to choose another
reached node

isChosenOK = checkNode ( chosen ) ;

}

return chosen ;
}
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C.3 Vytvářeńı výstupńıho souboru

private void writeOneRule ( F i l eWr i t e r fw , Rule r ,
Graph g , boolean gui ) throws IOException {

outputBuf fer = new St r i ngBu i l d e r ( ) ;
f ina l St r ing l s = LINE SEPARATOR +

LINE SEPARATOR;
f ina l St r ing l s s = l s + LINE SEPARATOR;

outputBuf fer . append ( Language . getValue ( ”
o r i g i n a l r u l e ” , ”Or i g i na l r u l e : ”) )

. append ( l s )

. append ( r . t oS t r i ng ( ) )

. append ( l s s )

. append ( Language . getValue ( ”m o d i f i e d r u l e
” , ”Modif ied r u l e : ”) )

. append ( ” ( ”)

. append ( g . getAdornment ( ) )

. append ( ”) ”)

. append ( l s )

. append ( g . t oS t r i ng ( ) ) . append ( l s s )

. append ( Language . getValue ( ” f i l e s i p ” , ”
SIP : ”) )

. append ( l s ) ;
outputBuf fer . append ( writeEdges ( g , fa l se ) ) ;
outputBuf fer . append ( l s )

. append ( Language . getValue ( ” f i l e f s i p ” , ”
FSIP : ”) )

. append ( l s ) ;
i f ( ! gu i ) {

transformSIPtoFSIP ( g ) ;
outputBuf fer . append ( writeEdges ( g , true ) ) ;

}
else

outputBuf fer . append ( Language . getValue ( ”
n o f s i p ” , ”( not c rea ted ) ”) ) ;

fw . wr i t e ( outputBuf fer . t oS t r i ng ( ) ) ;
fw . c l o s e ( ) ;

}
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C.4 Ukázka optimalizace kódu

C.4.1 Původńı kód

outStr += Str ing . format ( ”{%s} %s−− %s %s−−> %s%s ” ,
v i s i t edNodes . get ( i ) , separatorN ,
v a r i a b l e s . get ( i ) , separatorV ,
FSIP ? g . getEdgesFSIP ( ) . get ( i ) . getDstNode ( ) .

getNodeName ( ) :
g . getEdgesSIP ( ) . get ( i ) . getDstNode ( ) .

getNodeName ( ) , LINE SEPARATOR) ;

C.4.2 Optimalizovaný kód

outputBuf fer . append ( ”{ ”)
. append ( v i s i t edNodes . get ( i ) )
. append ( ”} ”)
. append ( separatorN )
. append ( ”−− ”)
. append ( v a r i a b l e s . get ( i ) )
. append ( ” ”)
. append ( separatorV )
. append ( ”−−> ”)
. append ( ( FSIP ? g . getEdgesFSIP ( ) . get ( i ) .

getDstNode ( ) . getNodeName ( ) :
g . getEdgesSIP ( ) . get ( i ) . getDstNode ( ) .

getNodeName ( ) ) )
. append (LINE SEPARATOR) ;
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D Ukázka výstupńıho souboru

Original rule:

intersection(Line1, Line2, Element, Level1) :-
xml(Line1, Element, Order, Level1),
xml(Line2, Element, Order, Level1),
dec(Level2, Level1),
intersection(Line1, Line2, _, Level2).

Modified rule: (fbfb)

intersection_h(Line2, Level1) :-
xml.1(Line1, Element, Order, Level1),
xml.2(Line2, Element, Order, Level1),
dec.1(Level2, Level1),
intersection.1(Line1, Line2, _, Level2).

SIP:

{intersection_h} --------- Level1 ----------> xml.1
{intersection_h} --------- Line2, Level1 ---> xml.2
{intersection_h} --------- Level1 ----------> dec.1
{intersection_h} --------- Line2 -----------> intersection.1
{intersection_h; xml.1} -- Element, Order --> xml.2
{intersection_h; xml.1} -- Line1 -----------> intersection.1
{intersection_h; dec.1} -- Level2 ----------> intersection.1

FSIP:

{intersection_h} --------- Line2 ---> intersection.1
{intersection_h; xml.1} -- Line1 ---> intersection.1
{intersection_h; dec.1} -- Level2 --> intersection.1
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E Uživatelská př́ıručka

E.1 Překlad

Pro překlad je nutné mı́t nainstalovanou Javu verze 1.7 (nebo nověǰśı) a nástroj
Apache Ant.

Překlad aplikace se provád́ı pomoćı př́ıkazu ant build.xml v př́ıkazové
řádce. Soubor build.xml muśı být ve stejném adresáři, kde se nacháźı adresář
src a soubory s definovanými lokalizacemi (soubory s př́ıponou properties1).

Výsledkem překladu je jediný spustitelný Java archiv SIPBuilder.jar.

E.2 Spuštěńı

Přeloženou aplikaci je nutné spustit z př́ıkazové řádky, nebot’ vyžaduje parame-
try, které by nebylo možné zadat při spuštěńı rovnou z pr̊uzkumńık̊u soubor̊u.

Aplikace se spoušt́ı takto formátovaným př́ıkazem (bez uvozovek):

java -jar SIPBuilder.jar ’-par1=val1 -par2=val2 ...’

kde par je název parametru a val jeho hodnota. Jednotlivé dvojice par=val
(parametr a hodnota) jsou odděleny mezerou a v názvu parametru, hodnotě
parametru a okolo znak̊u = (rovńıtko) a - (pomlčka) nesmı́ být mezery. Možné
parametry lze vidět v tabulce E.1 na straně 58.

Parametr lang určuje jazyk aplikace a neńı povinný. Parametr file je po-
vinný, pokud hodnota parametru gui je no. Pokud ovšem parametr file zadán
nebyl, muśı být zadán parametr gui=yes. Jiné názvy parametr̊u, než které
jsou uvedené v tabulce, aplikace ignoruje.

1Název těchto souboru se v žádném př́ıpadě nesmı́ změnit, jinak z nich aplikace nebude
schopna nač́ıst jazyk.
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Název
parametru

Povolené hodnoty
(oddělené čárkou)

Výchoźı hodnota (nebyl-li
parametr zadán)

gui yes, no no
lang en, cs en
file cesta k souboru –

Obrázek E.1: Parametry spuštěńı aplikace.

Př́ıklady spuštěńı (posledńı př́ıklad je sice dobře, ale parametr abc aplikace
nezná a proto jej jednoduše ignoruje):

java -jar SIPBuilder.jar -gui=no -file=myProgram.pro

java -jar SIPBuilder.jar -gui=yes -lang=cs

java -jar SIPBuilder.jar -gui=yes -abc=cde

Pokud budou parametry zadány špatně (chyb́ı povinný parametr, nějaký
je zapsán ve špatném formátu, atd.), aplikace uživatele upozorńı výpisem do
př́ıkazové řádky a ukonč́ı se.

Př́ıklady chybného zadáńı parametr̊u (v posledńım př́ıkladu je sice název
parametru lang známý, ale parametr je ve špatném formátu):

java -jar SIPBuilder.jar -gui=no -lang=cs

java -jar SIPBuilder.jar -gui = yes

java -jar SIPBuilder.jar -file=myProgram.pro -lang

E.3 Ovládáńı

E.3.1 Dávkový mód

Aplikace v dávkovém módu nevyžaduje po spuštěńı již žádnou daľśı interakci.
Pouze do př́ıkazové řádky vyṕı̌se, jak dlouho běžela, a do adresáře output2

2Který vytvoř́ı, pokud neexistuje.
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přidá adresář, jehož název je složený z out_ a časové značky3. V tomto adresáři
jsou uložené vypočtené grafy.

E.3.2 GUI

Po spuštěńı s GUI (parametr gui=yes) se zobraźı okno z obrázku A.2. Má tři
části:

• Textové okno ve spodńı části, kam se vypisuj́ı doposud přidané hrany.

• Plátno - veliký panel s šedým pozad́ım v prostředńı části, ve kterém se
vytvář́ı a upravuje SIP.

• Horńı lǐsta s menu, které slouž́ı k ovládáńı aplikace. Má tři podmenu –
viz obr. E.2. Pro ovládáńı lze použ́ıt také klávesové zkratky uvedené na
pravé straně položky podmenu.

Obrázek E.2: Jednotlivá podmenu aplikace.

Nejprve je nutné nač́ıst pravidlo ze souboru4, což lze provést z nab́ıdky File
→ Open – tato položka menu vyvolá standardńı dialog pro výběr souboru. Po
otevřeńı souboru je uživatel dialogem (viz obr. E.3) vyzván k výběru řetězce
ozdobeńı, pro který bude graf předáváńı informace vytvářen. Jakmile uživatel

3Např. out_2015-04-27_02-07-39
4Pokud se ve vybraném souboru nacháźı v́ıce pravidel, je načteno pouze prvńı a ostatńı

jsou ignorována.
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řetězec ozdobeńı vybere, zobraźı se načtené pravidlo (se speciálńım predikátem
hlavy) na plátně - viz obr. E.4.

Obrázek E.3: Výběr řetězce ozdobeńı.

Obrázek E.4: Pravidlo zobrazené na plátně po výběru řetězce ozdobeńı.

Vybraný řetězec ozdobeńı lze kdykoliv změnit (což pochopitelně vyvolá i
restartovańı konstrukce SIPu) položkou menu SIP → Change Adornment
nebo zobrazit pomoćı SIP → Show Adornment.

Konstrukce SIPu se spust́ı položkou menu SIP → Go a lze ji kdykoliv
restartovat (se stejným řetězcem ozdobeńı) volbou SIP → Reset. Po spuštěńı
provede aplikace jednu iteraci konstrukce SIPu5 a poté nechá uživatele vybrat,

5Nebo v́ıce, pokud je možné do daľśı iterace vybrat jako zdrojový pouze jediný predikát.
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jakým predikátem chce pokračovat. Vybrat lze zeleně podbarvené predikáty
(viz obr. E.5 nebo po provedeńı několika iteraćı obr. A.3) levým nebo pravým
tlač́ıtkem myši. Do spodńıho panelu jsou pr̊uběžně vypisovány nově vytvořené
hrany (obr. E.6). Č́ıslo u pravého horńıho rohu predikátu udává pořad́ı, v jakém
byly predikáty vyb́ırány jako zdrojové (at’ už aplikaćı, nebo uživatelem). Text
vedle hrany je jej́ı ohodnoceńı – zobrazuje se vždy mezi dvěma prostředńımi
zlomy této hrany.

Obrázek E.5: Plátno po spuštěńı konstrukce SIPu.

Obrázek E.6: Výpis hran do textového okna spodńıho panelu.
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Jakmile bude konstrukce grafu dokončena, je možné jej uložit do textového
souboru (File → Save as.. → Text file) ve stejném formátu, v jakém grafy
ukládá dávkový mód. Volbou File → Save as.. → Image file lze také uložit
plátno jako obrázek ve formátu PNG. Pro obě tyto možnosti bude soubor
uložen do složky output_GUI pod názvem složeným z predikátového symbolu
speciálńıho predikátu hlavy, použitého řetězce ozdobeńı a časové značky6.

Check boxy v podmenu View slouž́ı ke změně zobrazeńı grafu na plátně.
Položka menu View → Show Variables schová nebo zobraźı ohodnoceńı
vykreslených hran, View → Show Arrows skryje nebo zobraźı šipky na hra-
nách, udávaj́ıćı směr přenášeńı informace. Položkou View→ Show Numbers
lze skrýt pořadová č́ısla v pravých horńıch roźıch predikát̊u. Na obr. E.7 vlevo
lze vidět fragment plátna se všemi zobrazeńımi zapnutými a vpravo se všemi
vypnutými.

Obrázek E.7: Změna zobrazeńı grafu na plátně.

Posledńımi ovládaćımi prvky aplikace jsou posuny objekt̊u po plátně, posun
plátnem a přidáváńı a odeb́ıráńı zlomů hran (velké černé tečky na hranách).
Tyto akce lze provádět kdykoliv, ale kv̊uli přehlednosti je doporučeno nejprve
dokončit konstrukci SIPu.

Celým grafem, resp. plátnem, lze posunout pohybem myši za současného
držeńı levého tlač́ıtka myši a klávesy Ctrl. Predikátem nebo zlomem hrany se
posunuje pohybem myši za současného držeńı levého tlač́ıtka myši a klávesy
Shift, přičemž krajńım zlomem hrany lze pohybovat jen po hranici predikátu
(přerušovaná čára), na které je tento zlom umı́stěn. Kliknut́ım pravým tlač́ıt-
kem myši na zlom, resp. čáru hrany, lze zlomy rušit (neplat́ı pro krajńı zlomy),
resp. přidávat. Graf po přidáńı a odebráńı některých zlomů a posunech zlomů
a predikát̊u lze vidět na obr. A.4.

6Např. child_fffb_2015-05-01_16-10-17.png
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F Obsah přiloženého CD

• adresář aplikace

– adresář javadoc – vygenerovaná dokumentace aplikace

– adresář src – zdrojové soubory aplikace

– adresář test – obsahuje použ́ıvaný testovaćı soubor (program.pro)
a složku s př́ıslušným výstupem dávkového módu

– soubor build.xml – Ant skript slouž́ıćı k překladu

– soubor language_cs_CZ.properties – česká lokalizace

– soubor language_en_US.properties – anglická lokalizace

– soubor SIPBuilder.jar – spustitelná aplikace

• adresář text

– adresář src – zdrojové soubory textu

– soubor text.pdf – text bakalářské práce

• soubor README.txt – popis adresářové struktury CD

63


	Úvod
	Logický jazyk
	Terminologie
	Úpravy jazyka pro úcely této práce

	Graf predávání informace
	Terminologie
	Textový formát
	Úplný graf predávání informace
	Finální graf predávání informace


	Konstrukce grafu predávání informace
	Algoritmus
	Ukázka aplikace algoritmu

	Specifikace implementace
	Implementace
	Struktura kódu aplikace
	Vlastní implementace
	Reprezentace dat
	Vstup
	Graf predávání informace
	Výstup
	GUI


	Další využitelnost
	Input
	InputFileReader
	RuleParser

	Core
	CoreController
	SIP

	Output
	AllOutput


	Testování
	Casová nárocnost

	Záver
	Obrázky
	UML diagramy
	GUI

	Testovací program
	Zdrojové kódy
	Tvorba hran grafu
	Výber uzlu
	Vytvárení výstupního souboru
	Ukázka optimalizace kódu
	Puvodní kód
	Optimalizovaný kód


	Ukázka výstupního souboru
	Uživatelská prírucka
	Preklad
	Spuštení
	Ovládání
	Dávkový mód
	GUI


	Obsah priloženého CD

